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Preface

This document describes the SL - ST Software Repository. The document includes descriptions of the underlying concepts.

We recognise and thank Razor for the use of their documentation included in this manual.

This manual is intended to be an abridgement only. It is in no way complete.

It’s intended purpose is to aid,  a limited number of users to begin to use the Repository, in advance to the system launch,  which will take place several months from now!

Could any suggestions,  regarding content, format or general be mailed to : Andrew.Bragg@cern.ch
Purpose

To act as a reference to the Razor suit,  Versions,  Threads, Issues.

The command line interface has not been taken into consideration at this time,  I direct users wishing to use the command line interface to the official release razor manual chapter 6.

A reference page is available on the Unix platform (where the command line interface is used).  To view this page simply input the following command at the command prompt :

$razor -h

(After the repository has been set-up,  see ‘logging into the repository’)

Scope

This manual is intended for user’s of the SL - ST software repository,  not librarians or administrators.

Logging into the repository.

From Unix

csh - and compliant

From the command prompt input the command,

% source ~razor/logrep.csh

On the input of this command you will be presented with the Graphical User Interface (GUI) Fig 1.1

Sh - and compliant

From the command prompt input the command, (note, ‘.’ Is not a random ink spot)

$ . ~razor/logrep.sh

On the input of this command you will be presented with the GUI Fig 1.1
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Fig 1.1

[image: image13.png]


The labels are in fact buttons,  By selecting a button with a mouse,  you will be presented with the following GUI  Fig 1.2








Fig 1.2

From this GUI you have the option of starting the interfaces to the repository.  Again the labels are in fact buttons.  By selecting one of the buttons with only one name                 e.g. Versions,  then the file versioning GUI will be started.  Selecting the button with all three names,  then all the interfaces are started.  By selecting ‘ No GUI’S yet thanks’  the environment has been set-up for the repository which you selected  Fig 1.1.  You can either start the GUI’s at a later time or use the command line interface.

What the names on the buttons mean

Versions 

= The file versioning tool.

Threads 

= The product release management tool.

Issues 

= The problem reporting tool. 

No GUI’s yet thanks 
= The environment is set-up for the selected repository,  but no                                                                                                                                                                  GUI’s are loaded,  this option would be selected for command line     interface.

You will notice that when you select a button from the GUI used to select the repository the following text is output at the command line:

“<repository_name>-Repository Environment Settings…”


        This reflects the button which was selected.

From a PC windows95/NT client

From the ‘start’ bar select :

1. The application group ‘Software Engineering.

2. The folder ‘Development’.

3. The folder ‘Razor’.

4. The appropriate tool,  Versions,  Issues or Threads.
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Represented below in figure 1.3











Fig 1.3

Note,  if the software group  ‘Software Engineering does not appear on your display then:

1. Select the software group  - ‘More applications’

2. Select the folder (which in this case is an icon)  -  ‘Show ALL NICE Menus’

3.  Click ‘OK’ to the dialog box displayed

4. Re-select the ‘start’ menu and follow the procedure described above

Starting Versions/Threads/Issues from a PC windows95/NT client
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After selecting one of the tools from the start menu (see above) you will be presented with the following screen  Fig 1.4,



Fig 1.4

When selecting any of the tools, Versions, Issues or Threads then the above screen is displayed, Fig 1.4

The first time that you start any of the tools from a PC windows95/NT client the ‘Universe Dir’ box  and ‘Host’ box are empty.

Type the following into the ‘Universe Dir’ box:

/user/razor/Razor_db/Razor_<Repository_Name>_db/RAZOR_UNIVERSE

Where <Repository_Name> is the name of the repository which you wish to access.

If you are not sure what repository names are available, from Unix type the command:

$ ~razor/reps.sh             

The available repository names will be displayed on screen

Type the following into the ‘Host’  box:

repsrv

Please leave the port number as it’s default :  16151
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On selecting ‘OK’ you will be presented with the following dialog box  Fig 1.5 :


Fig 1.5

The ‘User ID’ is your UNIX login ID.

The ‘Password’ is your UNIX Password.

Provided all goes well you will be presented with the GUI for the interface which you selected either Issues, Versions or Threads.

The Interfaces,  Versions,  Issues and Threads

The GUI’s are the same whether you choose to use a Unix xterm or PC windows95/NT clients.  The following diagrams were captured from the windows95/NT client…

Versions
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The Versions interface looks like Fig 1.6 :
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       Fig 1.6

The primary display

The main display of the versions program is dominated by a large scrolling window, as shown Fig 1.6 . As with most windows-based applications, much of its functionality is available through a menu bar across the top of the display. You choose commands from either a menu (along the top of the display), action buttons (along the right side of the display), or shortcut keys (shown with menu items). Action buttons provide convenient access to the more frequently used functions. 

Header/footer

The window header will contain the program name. The left footer of the display shows file statistics. The right footer will normally display the version number of the release of Razor you are using. 

Menu bar

The menu bar contains the menus File, Edit, View, Utilities, Scripts, Commands, and Groups. 

· File, contains file-related commands such as New Folder, Rename, and Exit. 

· Edit, contains editable items, specifically Tool properties. 

· View, contains a collection of view manipulation and selection commands, like selecting/de-selecting all items in the list and various filtering/sorting options. 

· Utilities, contains file-specific manipulation commands. This menu is only active when a file is selected in the main list. Utility commands include file

· Information, browse a specific version, revert to a specific version, display differences between file versions, and merge versions back together. 

· Scripts, contains user-defined scripts that manipulate file/folders. 

· Commands, contains CERN-specific commands. 

· Groups, contains a list of file control, issues, and threads groups available for this database. 

Action buttons

To supplement the menu bar, a column of buttons appears down the right side of the panel, for all of the common file version control activities (checking files in, obtaining read-only copies, etc.). These buttons will appear enabled or greyed out based on the status of the various files selected on the main list. For example, if no files have been selected by the user, then only the Introduce button will be available. This type of feedback and control makes use of the tool more intuitive. 

Main list

The scrolling list displays all of the files contained within the indicated group. In addition to the file names, there are three extra columns of information about each file

A small glyph is shown on the left edge of each line, and is meant to give a quick indication of what the name represents. Folders, used to represent a hierarchical directory structure, are displayed with a "folder" icon. They will be either open or closed, depending on whether the contents of the folder are to be shown. If the folder is open, then everything within the folder will be shown on subsequent lines, indented slightly to help show the hierarchical relationship. 

The next column shows the latest version of the file. 

The third column gives a quick indication of whether the file is presently checked out for edit by anyone. If the file is checked out for edit, then the UNIX login id of the person who locked the file will be shown. 

Changing groups
Files within Razor are organised by groups. The versions GUI allows you to view only one group at a time. The Groups menu bar option provides a pull-down selection of all the groups available. Selecting one will change the contents of the main scrolling list, and clears filter settings. 
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In addition to the `real' group names, you'll also see special menu items at the end of the Groups list for Threads and Issues, like the one below... Fig 1.7




Fig 1.7

Of course, your display may be different as these menu items can be turned on/off through the Tool properties. These special groups allow you to view how thread, project, and problem tracking data are stored within the Razor database. These powerful concepts are discussed in more detail throughout this chapter. 

Working with files/folders

The hierarchical database within the versions tool of Razor allows users to replicate an entire directory structure within a single Razor file group. This is a natural fall out of how many development environments are organised. 

A hierarchy consists of files and folders (subdirectories). There is no limit to the depth of the hierarchy. File names may be duplicated within a Razor file group as long as the files exist in different folders. 

Creating folders
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Folders are created with the New Folder option from the File menu (or type ^n), which brings up the following display. Fig 1.8

Fig 1.8                                                          

Another, perhaps simpler, method of creating folders is to select one or more directories for introduction from the Introduce dialog. Note that introducing a directory will introduce the directory and its entire tree, creating the necessary folders as it goes. 

File check-out/check-in from the hierarchy uses the specified directory as a base directory. When checked out for edit or checked out read-only, files will be placed into the same hierarchy in the file system as represented in the versions tool. The base of the hierarchy will be the directory specified in the dialog. When checked back in, files are expected to be in the hierarchy off of the base directory.

The threads tool will also honour your file hierarchy when populating a thread from a thread script. 

Introducing new files
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The first step in letting Razor help manage your version control needs is to introduce files into the database. To do so, make sure that you've set the program to the proper Razor group. If you wish to introduce files into an existing folder, you must select the destination in the files/folder list. Then, with the destination selected, select the Introduce button from the main display. The following panel will appear. Fig 1.9

Fig 1.9

Through this interface, you'll be able to guide the versions program around your directory system, identifying the files of interest, and inserting them into the database. 

There are two ways of using the panel to navigate around your system, and it is up to personal preference as to which is easier. The first is to type in the desired directory into the top text field. The use of tilde ("~") and environment variables is allowed. Upon pressing the carriage return, the scrolling list will update to show the contents of the directory. 

As an alternative, users may also `walk' around the directory system. By toggling what is displayed in the scrolling list, it is possible to display directory names in amongst the files. Double-clicking the mouse over a directory will cause the panel to enter it and update the contents of the list accordingly.

Either way, the current directory is always displayed just below the scrolling list itself. It is also possible to enter a file name pattern to restrict the files that are displayed in the list. The pattern text can be specified as either a UNIX style wild card or as a regular expression, based on how the toggle on the panel is set. 

TIP: it's possible to have the versions tool always start up at a specific directory, which eases or eliminates the need to drive the tool around in search of files. To learn more, see "Setting personal preferences" (See index for page reference). 

To introduce files into the system, highlight the files you are interested in from the scrolling list. You can select as many files as you wish. Then, set the attributes for the files from the options provided. 

The Expand Key words option allows control over archive engine key word expansion during check-out. By default, key word expansion is enabled, but you might have a reason not to if you have characters that look like key words. 

If you had a folder selected on the main display of the versions program, then whatever files you select on the introduce panel will end up being placed into the indicated folder. If no folders were selected on the main display, then the files will be introduced at the top of the group. If you select a directory on the introduce panel, then it will automatically create a folder of the same name, and re-cursively introduce everything within it.

TIP: If you can't find your file in a folder after you introduced it, check the top-level group. You might have forgotten to select a folder before you introduced the file. 
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Finally, decide how you'd like Razor to process the files by choosing one of the three possible actions shown here. Fig 2.0

Fig 2.0

Take the files tells Razor to check the files back into the database and remove the working copy from the originating directory. Leave READ-ONLY copies will check the files in and leave a read-only copy in the working directory. CHECK-OUT the files checks the files into the database and immediately checks them back out again for edit. This last operation is commonly referred to as a checkpoint. 

Once everything is set, selecting the Apply button will begin the procedure. A small pop-up will appear giving a running tally of how it's going. Once the selected files have been introduced, their names will appear on the main display list. Files already introduced will no longer be shown in the scrolling window of the Introduce panel. This prevents you from accidentally entering two files with the same name into the same Razor group. 

The Introduce panel will stay on screen after the manoeuvre, allowing you to introduce more and more files into the system. Selecting Cancel will remove the panel from the display (but will not undo the introductions just made). 

Renaming files / moving to new folders
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Razor permits the rename of files that are under version control. The same interface may be used to both rename a file and move a file to a different location within the same Razor group. A move is simply renaming a file to a different location. Highlight the file in the versions list and select the Rename option from the File menu (or type ^r). This brings up the following dialog. Fig 2.1

Fig 2.1

It will come up showing the current name and folder. Simply type in the new name and folder you want it to have and select the Ok button. Note, that any existing threads which refer to the old name will still work properly. 

Handling binary files

By default, Razor will try to use either SCCS or RCS as the underlying archival engine for the file version control scheme. These systems work just fine in many situations, but some file formats require special handling. These are often non-ASCII files, and can be of any type; tar files, CAD files, documents from a word processor, etc. 

To accommodate this, if a file is identified as being binary at the time of introduction, then Razor will utilise its own scheme. In brief, the file will be compressed, renamed, and stored in the Razor database. These steps will be transparent to the user. 

The decision of whether or not a file is to be treated as ASCII or Binary must be made at the time of introducing the file. If you toggle the Archival setting to Binary, it will force the program to treat it as such. If you've chosen Auto-detect, then the versions program will try to decide for itself. If neither of these is selected, then the file is assumed to be ASCII, and it will be treated as such.

Checking files out for edit

Of course, the reason files are stored in Razor is to provide a controlled mechanism for access and modification. Developers obtain write-able copies of the files by selecting the ones of interest from the main display of the versions program and selecting the Checkout for Edit button. Doing so will bring up the following panel. Fig 2.2
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Fig 2.2

The user must first decide where the write-able copy of the file is to be placed. The directory name can be typed directly into the Check-out to field, or the ‘cd’ button can be used. Using the latter method brings up its own panel which allows the user to `walk' to the desired destination by mouse interaction with scrolling lists (reminiscent of the methods discussed for introducing files). 

For files being checked out that are included in one or more folders in the Razor database, they will be placed into the Check-out to location including the appropriate subdirectories. When the Path is absolute check box is selected, files will be placed directly into the Check-out to destination. 

The Clear button can be used to clear the title and description entries. Cancel cancels the check out action and returns to the main display. Help is,  well, help. 

Filling in comments

There are two mechanisms for associating user comments with the check-out. 

After specifying where the files should be placed, the user must enter a brief reason why he is checking the files out. This Title field must be filled in with something for the check-out request to be processed. 

Separately, the user has the option of entering a longer, more thorough set of comments in the Description field. These notes may be of whatever length and purpose deemed necessary. They will be stored in the Razor database, and can be recalled later as necessary to gain insight as to not only which files the user checked out, but what the thinking was at the time. 

NOTE: Many version control systems allow comments only when the file is being checked back in. Razor allows comments to be made both before and after changes are made to the files. The notes made during check-out of files can address what the developer is hoping to accomplish. These notes are shown during the check-in process, and may be modified to reflect what actually got done. 

Associating issues to editing activity

In addition to the above means of commenting on a check-out effort, users may directly relate the activity to one or more issues in the problem tracking system. In many ways, this makes more sense than making comments directly on the check-in or check-out panels themselves.

This is very powerful. It allows you to use the problem tracking system as the heart of your development process, allowing you to directly associate what you are doing against the stated reason of why you're doing it. This can come back and help later as you pull together threads which define your product releases!

In order to do this type of association, you of course need to have both the issues and versions tools running at the same time on your display against the same database. Given that, the first step is to identify the relevant issues from the problem tracking system. Once done, there are two different ways to perform the association. 

The drag-and-drop method
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Once one or more issues are selected on the main display of the issues program, a small icon will appear to the right of the toolbar, just below the menu on the main display. Grabbing this icon with either the Select or Extend mouse button allows you to drag it over to the small scrolling list on the check-in/check-out panel. This icon only appears if you are using Razor's version control tool and have groups defined in the database. Of course, if you never create a versions control group, then you will never see this icon Fig 2.3

Fig 2.3

You can repeat this manoeuvre as many times as necessary. 

The copy-and-paste method
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After selecting one or more issues from the main display of the issues program, the user may use the menu button of the mouse to bring up a small list of options. Choosing Copy Issues will push the list onto an internal clipboard area for later use. Fig 2.4

Fig 2.4
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After the issues have been selected, the user then returns to the versions program and brings the cursor over the small issues scroll area on the panel.  Again, by using the menu button on the mouse, a short list of options will appear. Selecting Paste Issues will drop the issue numbers into the scrolling list. Fig 2.5

Fig 2.5

This Copy-Paste effort can be done as many times as necessary to get an accurate list. The menu associated with the small issues list also allows the user to select and deselect all members of the list as well as delete members from the list if necessary. 

TIP: If the issues program is running on your display against the same database (which it probably is), you can double click on any of the issue numbers in the scrolling list to view a copy of the full issue for review and possible modification. 

The steps outlined here for associating issues to a check-out activity are the same as those that can be used wherever version control commentary is allowed. This includes checking a file back in, introducing new files to the database, etc. 

Checking files back in

[image: image33.wmf]Header

Menu bar

List of all

defined threads

for this group

Footer

This column shows

the highest version

number for each of

the defined threads

in this group

[image: image34.png]


After files have been modified, they must be re-entered into the database. To do so, the user first selects the relevant files from the main display of the versions program and selects the Check-in button. Fig 2.6

Fig 2.6

Since the user must have already checked out a file, many of the fields on this form will be familiar, and don't warrant a repeat discussion. There are a few extra elements to the check-in effort though that do require some explanation. 

As files are being checked back into the database, the user has the option of either having the edited copies removed completely from the directory, having read-only copies left in their place, or of directly checking the files back out again for edits. The preference is made in the upper right section of the form. The latter case of doing an immediate re-checkout is a convenient mechanism for check-pointing efforts into the database prior to a new wave of edits. 

As the files re-enter the system, the minor version number of each file will be incremented. For example, a file that was at 1.22 will now be at 1.23.  Local conventions may suggest that you occasionally increment the major number of the files. Selecting the Increment release number toggle will cause all of the files to re-sequence to the next major release number. In other words, a file that was at 1.22 will now be at version 2.1. 

Checking in multiple files

When multiple files are being put back into the system at the same time, the user has the option of either having the same Title, Description, and related Issues be associated with all of the files, or have the original commentary from the various check-out efforts be recycled for the check-in. This is controlled through the Use toggle in the middle of the display. 

TIP: When multiple files are being checked back in, the comments from the first in the list are offered to the user on the check-in panel as a reminder of why the files were checked out in the first place. Highlighting different files in the scrolling list in the upper left of the display will cause the Title, Description, and Issues information to update accordingly.

Parallel development

Performing a branch
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Branches are deviations from the main development line for a file. They are a convenient mechanism for allowing two or more people to be working on the same file at the same time (perhaps for different goals). A common scenario is having one person working to add new features to the product, while a second is doing bug fixes on prior versions. 










Fig 2.7

The version numbers of branches can be a little confusing, and warrant a quick discussion. Version numbers on the main development line have only two parts; a major and minor number. Branches have 4 parts to their numbering scheme. The first two parts represent the point at which the branch split off the main line. The third number indicates which of the many possible branches it is. For example, in the diagram above, we have only one branch originating from 1.5. As such, its numbering starts at 1.5.1.1, and proceeds from there. 
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If a second branch is later formed from 1.5, then it's numbering will begin with 1.5.2.1, as shown below. Fig 2.8

Fig 2.8
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To create a branch, the user highlights the file of interest from the main display, and selects the Branch button. A pop-up will appear, as shown below. Fig 2.9

Fig 2.9

As with checking a file out for edit, the user is required to enter some explanatory text in the Title field. A more elaborate set of comments may be entered in the Description field. One or more issues may be associated with the action. Once a branch has been created, it presents itself as a separate line on the main versions display, and it can be checked in and out for edits as necessary. 

Terminating a branch
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It is expected that branches are used as a temporary means of allowing concurrent development on a single file. Sooner or later, the edits made to the branched line will be incorporated into the main evolutionary line for the file. After that occurs, the branch has out lived its utility, no longer needs to evolve separately, and no longer needs to be presented on the main scrolling list. 



Fig 3.0

To signal the end of the utility of a branch, highlight the branched file in the main scrolling list and select the Terminate Branch button. The above pop-up, Fig 3.0 will appear, asking for confirmation of the effort before performing the action. 

Note that although a branch has been terminated, none of the work that went into it is lost. The branched versions are still available from the database, threads which referenced them are still valid. New and modified threads cannot reference terminated branches. 

Merging files

If development is being done in parallel, it is sometimes the case that two files must be merged into a single file. An example of this is Mike has a file checked out implementing a new feature, a bug is identified in the same file and needs to be resolved quickly. Al branches the source file to fix the bug while the Mike continues his implementation. When Mike's new feature has been completed, the bug fix needs to be rolled back in and the branch terminated (assuming Al finished his bug fix before Mike finished his implementation :). 

Merge compares three files (the two input files and the common ancestor), and displays the comparison in a series of panes: one for each difference and common section. Each section, either common or different, can be independently included or excluded from the merge output. Wherever one current version agrees with the ancestor, merge presumes that the other current version is a deliberate change which should be kept, in the merged          version. 

NOTE: Merge uses a common ancestor approach to control the merge selection    algorithm. If a common ancestor is not available, as in the case of merging a file outside of Razor, File2 will be used as the common ancestor. The ancestor is very helpful in providing context for differences and for conflict resolution. 

File selection
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To merge files, highlight a file from the main display of the versions program and select the Merge option from the Utilities menu. A dialog similar to the one below will appear. Fig 3.1











Fig 3.1

While strictly speaking the order of the files does not matter, the merge algorithm will be better served if the Merge file (we will refer to as File1) is thought to be merged into the `Merge with' file (referred to as File2), just as the file selection pull-down menus suggest. 

The Check-in as Latest Trunk check box is enabled if the file is not currently checked out for edit, and File 2 is selected from Razor. The Terminate Branch check box will be enabled if File 1 is selected from Razor, the Check-in as Latest Trunk check box is selected, File 1 is a current branch (that is, not a previously terminated branch), and the File 1 branch is not currently checked out for edit. 

Difference display
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The main merge window is divided into three major areas: the ancestor area, the difference area, and the merge result area. Each of these areas can be resized. Below is a sample display with the major areas identified...  Fig 3.2

Fig 3.2

The ancestor area includes the browse buttons (for the original files and the ancestor file), a compare button (to re-execute the compare if merging a file outside of Razor), and the merge button. The ancestor file becomes the reference point for differences as well as resolving potential conflicts between files. The ancestor file is the lowest common version between the two merge files or File2 if one or both of the merge files is outside of Razor. 
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Differences are displayed in the Difference area in a series of panes - one for each difference between the two files and optionally the common text between the two. The difference area is where most of your attention will be concentrated. The important components are.... Fig 3.3
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Fig 3.3

In the difference area, a difference is visibly cued by its position, being left-oriented (change from File1), right-oriented (change from File2),  side-by-side (change from both File1 and File2) or the full pane (text common to all three files). Each difference has one of these states (the state can be displayed by selecting on the Ancestor button to display the message in the status area): 

· Text common to all files.

· Text has been modified or added to both files. 

· Text has been added to File1 or File2. 

· Text has been deleted from File1 or File2. 

· Text in all three files is different (referred to as a conflict).

Interactive merging, a walk-through

After the comparison is done and the differences displayed, the interactive merging starts. The first thing you will notice is the merge display is completed and a message is written to the status line with the number of conflicts. In the simplest case, that is - no conflicts, you could probably select the Merge button to copy the results to the merge output area, and then save the results either to a file, or check the merge back in to Razor. 

Let's walk through an example of merging the efforts of our two programmers mentioned earlier. In a perfect world, the programmers did not modify the same sections of code and you want all of the changes from both. In that case, go buy a lottery ticket because you've beaten the odds. 

Now for the real world, while the objective of the two programmers was different, they editorialized and managed to change the same section of code in different ways. This is called a conflict. The most challenging task in merging files is to resolve conflicts (much as it is in life.) You select which panes get included in the merge result by selecting the Include/exclude toggle button. By default, merge will pick what it thinks is the best choice for the merge result. Say merge notices that text was added to File2 and the text did not exist in File1 or the ancestor, then it will decide to include the new text in the merge result. If there is no clear "winner," such as when the text is different in all three files, merge will punt and choose File2. 

NOTE: Merge will generally produce reasonable output if you pick two files that came from a reasonable ancestor. It really helps if both files are managed by Razor, as you might expect. But however good the algorithm is, merge is not a mind reader. Care must be taken to understand the differences and how they should be merged to produce the final product. Don't just "merge and go!" 

So how will various differences be displayed? Consider the following code snippet for the ancestor... 

/* Extended regular expression matching and search library,

 
   version 0.12.







 (Implements POSIX draft P10003.2/D11.2, except for internationalisation features.) Copyright (C) 1993 Free Software Foundation, Inc.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation; either version 2, or (at your option)  any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for more details. You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.  */

#include <string.h>







     #ifndef bcmp







  #define bcmp(s1, s2, n) memcmp ((s1), (s2), (n))




 #endif








    #ifndef bcopy







  #define bcopy(s, d, n)  memcpy ((d), (s), (n))




     #endif








    #ifndef bzero 







  #define bzero(s, n)     memset ((s), 0, (n))




     #endif








  #define REGEX_MALLOC

/* AIX requires this to be the first thing in the file. */

//#if defined (_AIX) && !defined (REGEX_MALLOC)



        //jeb  #pragma alloca







   //#endif








   #define _GNU_SOURCE
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Here is a sample of some merge outputs and a short explanation. With each of these examples, the difference pane and the highlighted ancestor section will be shown.  Fig 3.4

Fig 3.4

[image: image46.wmf]Integrated with

Razor’s version

control

Files under Razor

control or external

can be merged

Common ancestor

Unchanged text, Fig 3.5

Fig 3.5

Text added to one file, Fig 3.6

[image: image47.png]Merge: AP/README

Merge:  selocted version

T~ Checkin as Latest Trurk.
1= Termiete Brerch

Wik selected version

1122
1121
1171

Caresl e














Fig 3.6

Text modified or added to both files, Fig 3.7
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Fig 3.7

Text is different in all three files.

The above case highlights a conflict. Read on... 

I'm sure you've turned to this section looking for really inspiring words of wisdom on how to resolve conflicts. Sorry. We can only tell you the mechanics within the merge interface to make the changes. You have to do the hard part. 

Interactive selection/edit of the merge result for each pane is controlled by the three edit control buttons and one of two include pane toggle buttons shown below.  Fig 3.8
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Fig 3.8

The pencil button enables editing of the difference pane, and changes the background colour to show that it has been enabled. Normally difference panes are not editable. Text can be entered or pasted from another source once editing is enabled. If you really blew it, you can undo edits with the Undo button. This gives you the ability to make little tweaks, or to completely change the text that will be merged.  The Ancestor area highlights the related difference section in the ancestor. If there is no line in the ancestor file, the single line prior to the difference section will be highlighted. 

The square and diamond toggle buttons enable or disable the difference pane's inclusion into the merged output. By default, merge will always select asection for inclusion, even if conflicts exist. In the case of conflicts, merge picks File2 but can certainly be overruled by toggling the button, or eitherpane can be edited and selected. To make editing changes, select the square/diamond button to enable it, then edit the pane. Once a change has been made, the background color will change to show that it has been edited.

Saving merged output

When you've got something you're happy with, select Merge and your merge selections will be copied to the merge result area. Once you have something in the merge result, you have the option of saving the output. Merge results can be written to a file, or checked directly back into Razor. 

TIP: To have the merged result checked back into Razor, the Check-In as Latest Trunk check box must have been checked when the files were selected. Also, File2 must be a Razor file - because that is the file you are merging into, and cannot be checked out. 

Controlling the merge view

If the amount of information is oppressive, you have several display options that effect how and how much information is presented. These options are all controlled under the View menu. 

· Each difference pane can be re-sized and subsequently reset with the Restore Diff Pane Height (^R) option. 

· You can hide/show the common sections of both files by selecting the Hide Common Data (^D) option from the View menu. Select Show Common Data (^D) to show all data, common or differences. 

· Since resolving conflicts is a key aspect of merging files, just conflicts can be displayed with the Show Conflicts Only (^S) option. All differences can be displayed by then selecting the Show Differences/All (^S) option.

Changing attributes of files

As defined by your local configuration of the versions program, files within Razor groups can have various attributes associated with them. These attributes are set at the time the files are first introduced to the system, but they can be changed later as the need arises. 
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To change the properties associated with a file, select the file from the versions list. Selecting Edit file props from the Utilities menu will bring up the following panel. Remember that the nature of the attributes can differ dramatically from group to group. 

Fig 3.9

The user can then use this form to change the nature of any of the attributes. 

The top of this panel offers a special `attribute'... control over the execute permissions of the file. Files will be archived with the execute permission setting at the time they were introduced. 

Archive engines such as SCCS and RCS have special keywords that can be included in source files and expanded automatically upon check-out.

These keywords include such things as the file name, version identifier, date, etc. and are typically embedded in a comment or identifier string for informational purposes. It is sometimes undesirable to have keywords expanded if they also have a different meaning within the file. Archive engine keyword expansion can be enabled/disabled from this form. 

The binary attribute of file is determined when it is introduced. The Binary indicator may not be modified. 

Promoting specific versions
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To do a promotion, the user would highlight one or more files from the main scrolling list of the versions program and select the Promote button. The following panel will appear.     Fig 4.0

Fig 4.0

The panel allows the user to promote a selected version of the file to one of the allowable state levels. This promotion can be associated with one or more issues from the problem tracking system (as discussed earlier), and can even have some supplementary text as well. Each time the Apply button is selected on the panel, it will sequence to the next file that was chosen from the main display. 

Looking at files

There are a variety of mechanisms available through the versions program to examine not only the files under control, but also various bits of information associated with these files. 

Getting read-only copies
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It's possible to obtain read-only copies of any files in the database by first highlighting the ones of interest and then selecting the Checkout Read-only button on the main display.

Fig 4.1

If a single file was chosen, then the user will be able to select a particular version of that file, as shown above. If several were chosen from the main display, it is assumed that the latest version of each is desired. 

The user must fill out the "Checkout to" field on the panel to indicate the directory where a copy of the file should be placed. As with many of the similar interfaces, this can be done by either typing directly into the text area, or by using the "cd" button. In either case, once set, selecting the Ok button will deliver read-only copies of the indicated files. 

Files that are included in one or more folders will be placed into subdirectories (referred to as folders within the versions program) of the "Checkout to" destination. When the "Path is absolute" check-box is selected, files will be placed directly into the Checkout to destination. 

Browsing files

By double clicking the mouse over a file on the main display list, a temporary read-only copy of the file will be retrieved from the database and brought up in a simple text window for display. 

The default behaviour is to use a simple Motif style text pane for showing the contents of the file. Razor allows you to override this behaviour and bring up the file in any editor you wish. 

Reviewing history

Nearly every user action against files in the Razor database is recorded. Of special interest are all the comments that were made as the files were checked in and out.

By highlighting a single file from the main display list and then selecting the Info option from the Utilities menu, the above panel will appear. Within it is a full accounting of the Info and History files that are part of the Razor database. 

Seeing how versions/files differ
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Every version of a file under the control of Razor is recorded in the Razor database. It is often handy, to be able to quickly and easily view the changes that occurred in a file between versions. By highlighting a file from the main display of the versions program and selecting the Diff option from the Utilities menu, a panel similar to the one below will appear. Fig 4.2

              Fig 4.2                                                               
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The Compare option allows you to control whether you will be comparing two different versions of the same file, or whether the program will compare a file within the Razor database against an existing file in your directory structure. 

  Fig 4.3

You can also control the nature of the output that the comparison will generate, as shown by the Options selection above. Fig 4.3

After identifying which files and versions will be compared, selecting the Apply button will result in a display similar to the one above Fig 4.2. A series of key symbols will appear between the two sides. If the centre column is empty, then those portions of the file are identical. A greater than or less than symbol will be used to point to which side contains unique lines relative to the other. A vertical bar indicates that the identified lines are similar, but appear to have been edited. 

The output may be saved using the Save button. A dialog popup will appear to allow the user to enter a directory path and filename. 

For more information, or a better understanding of this option, we'd encourage you to refer to the man pages for sdiff on a UNIX platform.

Changing your mind
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Although the linear evolution of information in a file may be a nice goal, it is seldom obtainable in practice. The straight check-in, check-out actions described above result in a flow similar to the one diagrammed below. Fig 4.4




Fig 4.4

In the following sections we will explore some variations to that flow. 

Uncheck-out files

It is frequently the case that a person will check out one or more files for modification, and later decide that more files were checked out than were really needed, or that the edits were not worth putting back into the database. In this case, the affected files would need to be unchecked. Doing so frees the permission lock on the files without incrementing the version number, or affecting the file archive. 
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To do this, the user simply selects the files checked out from the main display list and selects the Uncheckout button. A small popup will appear. Fig 4.5



Fig 4.5

The user will have a choice that the file remain where it was, or have it replaced with a read-only copy of what it looked like prior to the check-out. It is assumed for this action that the file has not been moved from where it was checked out to. 

Reverting files
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Occasionally, a situation may occur where modifications were made to a file, and you wish to back them out. In effect, you'd like to revert to a prior version of a file and pretend that the edits never happened. The Revert option from the Utilities menu allows you to do exactly that. 

Fig 4.6

Rather than delete the intermediate versions and completely lose whatever engineering effort went into them, Razor allows you to take an earlier version of a file and leap-frog it to the front of the evolutionary line.
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Fig 4.7

Controlling your view

Displaying modification dates
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Although not mentioned earlier, you are allowed to customise the information displayed on the main scrolling list. Through the View menu option, you can show the date that each file was last modified, and/or the number of days that have elapsed since the check-in occurred.

Fig 4.8

By enabling the Days since last mod (^l) option from the View menu, the display will widen and add a note of the number of days since the file was last modified. Similarly, you can choose the Modification date (^m) option from the View menu and the main display will now include the exact date of the last modification of the issue. 

As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year of the modification. Dates less than 6 months ago will display the date and time of day that the edit occurred. 

The above menu and associated hot-keys also give the user the ability to quickly open up a selected folder, close a folder, select all files within a folder,  etc. 

Filtering the display

The versions program allows you to have hundreds or perhaps thousands of files within a single Razor group. This in turn can yield a particularly long and unfocused list being presented on the main display. 

It's possible to reduce and restrict the list to only those files which meet certain selection criteria. Selecting the Display Filter option from the View menu (or using the ^F hot key) will bring up the following control panel. 
[image: image62.png]v Diferent versions of thisfe
Wih a il outside of Razar




[image: image63.png]Donitshow deriical lines.
Orly show et ide ofidentical nes.





Fig 4.9

Perhaps the best way of becoming familiar with the concepts of filtering the display list is to simply experiment with the above panel. Nonetheless, the following notes should help you understand some of the basic themes. 

By entering text in the Filename pattern field, you can restrict the list to only those files that follow a particular naming convention. For example, entering the string "land*.c" will prune the list to include only those ".c" files beginning with "land". The Options menu allows you to toggle between using normal UNIX style wildcarding or regular expressions for matching. 

NOTE: File names must include the folder name in order to match. 

The Availability section gives you the ability to restrict the list to only those files that are either checked in, or out for edit. It even allows you to quickly prune the list down to only those files out for edit by a particular user or list of users separated by spaces. Furthermore, you can apply the filters to either files on the main trunk of their evolution, or those that have branched. 

Filtering by date modified
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If you're interested in only viewing files that have been edited during certain time periods, then you can take advantage of the Modified range field. Whether or not this criteria is used for filtering of the list is controlled by the Disable toggle on the right side of the display. Selecting the Modified range button will bring up a special panel for the entry of the desired date range. Fig 5.0

Fig 5.0

The two rows of controls are used to define the beginning and ending of the date range. Users can either fill in the values by direct interaction with the buttons and text fields themselves or by taking some of the shortcuts on the menu bar which allow quick entry of relative dates, such as `Yesterday', or `One week ago'. 

Filtering by matched attributes

The bottom section of the filter panel allows you to restrict the list to only those files that match particular attribute settings. The nature and meaning of the attributes are configured by your local administration and will most likely differ from what's shown in the example. 

Executing the filter

As restrictions are entered on the panel, the left footer will show a count of how many files within the group match your interests. Selecting the Apply button will cause the matched files to be displayed on the main list. It's possible to have the count updated either on a keystroke by keystroke basis, or only after typing a tab or carriage return. This personal preference is set from the Match while typing option of the Options menu item of the filter panel itself. 

Setting personal preferences

Certain aspects of how the versions program behaves are configurable on a user by user basis. Each user can set defaults which control how the program will initialise, execute, and react in specific circumstances. A panel which lets you control these aspects of the program can be brought up via the Tool Properties option on the Edit menu.
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Fig 5.1

As noted on the panel itself, some settings will take effect immediately, while others require a restart of the program. In the first category, you can control whether or not the versions program will warn the user if a pending operation will affect an existing file on disk. Some people like this extra level of caution; some don't. The user can also set whether or not the directory field on the check-in panel is automatically filled in with the directory that the file was originally checked out to. User's can also hide the display of thread groups and/or issues groups from the Groups pull-down menu. 

By default, the versions program will come up showing the first group in the Razor database, as determined by an alphabetical sort. Setting the selector on the above display overrides that behaviour.

Finally, through the last option on the display, user's can define the directory where files should be normally checked out via a chooser dialog. This minimises the need to re-enter that information each time the program is invoked. 

Treads
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The Threads interface looks like this,  Fig 5.2


Fig 5.2

As with the other Razor programs, the main display is dominated by a large scrolling list containing the names of all the existing threads for the defined group.

Header/footer

The window header will contain the program name. The left footer of the display shows file statistics. The right footer will normally display the version number of the release of Razor you are using. 

Menu bar

The menu bar contains the menus File, View, Utilities, Commands, and Groups. 

· File, contains file-related commands such as New Thread and Exit.       

· View, contains a collection of view manipulation and selection commands, like modification dates and filtering options. 

· Utilities, contains threads manipulation commands like compare, generate, and extract. 

· Commands, contains CERN-specific commands. 

· Groups, contains a list of threads groups available for this database. Selecting a different group will refresh the list. 

Main list

The scrolling list displays the file name of each thread contained within the indicated group. Each thread is shown with its highest version number. 

Creating and editing threads

To create a new thread, select the New Thread option on the File menu of the main display (or take advantage of the hot key, ^N). To edit an existing thread, use the mouse to double click over the thread of interest. 
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In either case, the Edit Thread panel will appear on the display, overlapping the main threads window. Note that while a thread is being created or edited, the main window of the threads program becomes inoperative. You can only manipulate one thread at a time. Also, while editing an existing thread, all other users will be locked from accessing that thread until the edit session is complete.
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Fig 5.3
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The Edit Threads window lists every file within the defined Razor group, much as the versions program would. The information displayed however is slightly different. Not counting the glyphs which appear next to the file names, there are four columns on the display.

Fig 5.4

The first column will contain a "+" if the file is included as part of the thread definition. If it is not to be included in the thread, then this column will be blank, as is the case for the file "Notes" above. For files that are part of the thread, the 3rd and 4th columns show the latest version of the file, and which version is actually included in the thread. 

There are three means of editing a thread definition, as detailed in the following sections. 

Importing an existing thread

It is possible to absorb an existing thread definition as the starting point for creating a new thread, or as a means of picking up where another thread left off. Selecting the Import option from the (Edit Threads) File menu will bring up the following panel. Fig 5.5
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Fig 5.5

A list of all the existing threads for the group appears in the upper left corner of the panel. As selections are made from that list, the upper right window will update to show all of the possible versions of that thread. As the selected thread/version changes, the Title and Description fields will update accordingly. After choosing a thread/version combination, selecting the Ok button will update the current thread to the same definition. 

Importing a version of a thread does not completely overwrite the version being edited. For example, let's say a file was not included in version 1.5 of a thread but was included in 1.6. Further more, someone edits 1.6 and then imports 1.5, the thread (which will now be saved as 1.7) will include the file that was excluded in 1.5. That being said, the best way to think of importing a thread is that it works as a mask rather than an overwrite. 

File by file decisions
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As files are highlighted on the Edit Threads display list, a small popup will appear. It allows the user to decide on a file by file basis whether it should be included in the present thread definition.

Fig 5.6

If the indicated file is excluded from the thread, then the scrolling list is inoperative. Otherwise, it shows all of the possible versions of the file that can be referenced. Modifications to this popup panel have immediate effect on the definition of the thread and are reflected on the main list itself. This option provides the user with the highest granularity control over what file/version combinations belong in the thread. 

Including the latest version of every file in a thread of perhaps greater utility than the file by file process described above, is the ability to make broad, sweeping decisions as to what file/version combinations should be included as part of a thread definition. 
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The simplest case is where we want to define a thread that includes all known files at their most recent version. Choosing the Blanket Selections option from the (Edit Threads) Selections menu (or using the ^B hot key) will bring up the following panel. Fig 5.7

Fig 5.7

To select the latest versions of all files, we'd set the top selector to Included, and apply the decision to All Files. We would not restrict the action to any particular file-type or Blessing. All that would be necessary to enact the choice is to select the Ok button at the bottom. 

Blanket selections

Let's build upon the concept of making broad file/version selections for a thread. Blanket Selections has some powerful capabilities to enhance file selection. 

The interface is divided into three key areas. Working up from the bottom, we have... 

1. A list of attributes relative to the files within this group. This will be somewhat similar in style and intent to the filter panel which is used in the versions program. It allows the user to define the scope of files to be included in the selection. If none of the options for an attribute are selected,  then there is no specified preference for that attribute, and it is a guaranteed match. For example, if we wanted to select only the "Doc" files, then that's the only File-type that would be highlighted. 

2. The scope of the selection can be further refined with the Apply to option. This defines what files in the group or thread the selection will be applied to.

3. The top selector controls whether the files identified by the selection are to be included or excluded from the thread. You can not perform both include and exclude actions with one blanket selection, so it may take more than one selection to complete your thread update. 

A few examples may clarify how this interface can best be used. 

· Say we wanted a thread that included not the most recent version of each file, but instead the version that had last been brought to the Tested state. Simply set the Blessing field to Tested. 

· We can use multiple passes with the blanket selection process to produce some nicely tuned effects. If we wanted to combine the Tested versions of most of the files with the latest version of the scripts, then we would first perform the selection described above, and then restrict the scope to the Scripts and set the Blessing to Active for a second pass. 

Increasingly complex illustrations can be made. The point is that through a little forethought and a combination of the preceding functions, it is possible to quickly pull together any thread definition you choose. 

Defining threads by related issues

If you've been diligent enough to stay with our documentation to this depth, then we'll reward you with what is perhaps the greatest gem in the Razor crown. You can define which versions of which files go into a thread by whether or not they were affected as a result of working on one or more issues.

This is important, and bears repeating... You can define which versions of which files go into a thread by whether or not they were affected as a result of working on one or more issues. 

From the (Edit Threads) Selections menu, choosing the Include based on issues option will bring up the following panel. Fig 5.8

[image: image76.wmf]Submitted

Rejected

Feedback

Closed

Suspended

Accepted

Assigned

[image: image77.png]wnnn

sfdge
Problen report,
Problen report,
Problen report,

Corrupt printer urmeyrim—.
screen COrFUPLL  pogelectallems

Incorrect neasu T




                                                         

Fig 5.8

The panel basically feeds the user from the top down. 

1. From the issues main display, the user selects which issues to have considered for affecting the contents of a thread. The issues can be associated here by either the drag-n-drop or copy/paste methods. Notice that the issues can be included from any of the issues groups defined for the database. 

2. The middle section of the panel allows you to specify which file actions warrant having the file included in the thread. If file promotions are being considered, then the promotion level must be specified. You can choose whatever combination of actions you wish. Actions other than those specified may be entered in the Others field. 

3. The list of file/version pairs from the above decisions will be automatically generated and displayed for your review in the bottom pane. 

4. Selecting the Ok or Apply buttons on the bottom will perform the edits to the thread. 

The drag-n-drop method is typically used for selecting a small number of issues, so we support an alternative method. The Load button on the bottom of the panel lets you refer to an external file which specifies a full list of all issues to be included. This file has the form <issue#><issues group>, one per line. 

Saving it back to the database

After all of the necessary edits are completed, the new definition must be saved back to the Razor database. If this was an existing thread that has been modified, then selecting Save from the (Edit Threads) File menu will bring up the following panel. Fig 5.9
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Fig 5.9

As when checking a file back in from being edited, the user is required to enter a title line. A longer description of the change can be entered, as well as associating the action to one or more issues from the problem tracking system.

When the thread definition is saved back into the database, its minor version number will automatically be incremented (i.e. if it was at 1.5, it is saved as 1.6). By setting the Increment Release toggle on the panel, the user can force the major release number of the thread to go to whatever is entered as the new release number indicated. 

Finally, selecting the Ok button on the panel will cause the new thread definition to be stored back into the database. 
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If this is a new thread, the only possibility from the (Edit Threads) File menu is to Save As a new thread name, and the following panel will appear. Fig 6.0

Fig 6.0

A thread name must be provided, as well as a Title for the effort. And, as above, a longer text description may be provided and the action can be associated with one or more issues from the problem tracking system. 

Since this effort is in effect similar to introducing a new file into the versions program, you will also have the opportunity to provide the initial settings for the attributes associated with the thread. In the example above Fig 6.0, the Thread_type is being set to Experimental.

Selecting the Ok button at the bottom of the display will cause the new thread to be entered into the database at version 1.1. 

Extracting threads & generating thread scripts

The primary reason that threads are defined and recorded is that people need to gather the indicated file/version combinations together. This is often done for the sake of doing a full compilation of the source code, or for a formal hand-off of one sort or the other. 

The threads program accommodates this need in two ways: 

· The threads program allows the user to extract read-only copies of the thread files directly into a specified directory. 

· The threads program can generate a shell script which will obtain read-only copies of all the necessary files. 

Both the Extract Thread and Generate Script options are available from the Utilities menu. This menu is present on both the main display and the Edit Threads window. 
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Fig 6.1

The top left corner of the panel contains a list of all the threads for the indicated Razor group. As different threads are highlighted on that list, the scrolling list in the top right of the panel will update to show various versions of the thread. The Title and Description fields will also update as necessary to show what was entered at the time of creation. 

The Set output directory button allows the user to navigate to the directory where the files should be placed.  Alternatively, if Generate Script is selected from the Utilities menu, the [image: image82.png]This column
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following panel will appear. Fig 6.2

                Fig 6.2

The Thread and Version lists are as described for the Extract Thread panel. The Title and Description fields will also update as necessary to show what was entered at the time of creation. 

After selecting which thread/version the user would like to generate a script for, the destination directory for the thread script must be specified. This can be done by either typing it directly into the Output script for field, or by using the Set output directory button (which brings up a nice interface of its own). 

The script that is being generated will gather together the indicated files, but it needs to know where to extract the thread to. The Extract thread to field on the panel serves this purpose. Whatever text is entered there is what the script will use as the top of a directory tree. As such, it can be either an absolute path, or it can work relative to where the user is when the script is executed. It may also take advantage of shell environment variables (such as $HOME). 

When the Ok button is selected at the bottom of the panel, a shell script will be generated with the name rz_build<threadname>_v<version>. 

Thread rules

All the files within a thread do not need to follow the defined file hierarchy. It is possible to have the files distributed into a directory tree of your design and choosing. We don't recommend use of this approach except in unusual situations. 

NOTE: In other words, your thread should emulate your file hierarchy. 

The Thread_rules file in the Tables directory establishes the rule set for directing where each file in the thread should be placed. The file itself is similar to a series of case statements which determine the destination subdirectory name based on the attribute settings of each file. A short series of examples are perhaps the best means of illustrating how thread rules would be used. 

· If you expect that all of the files within a group can simply end up at the base directory itself, then all that's necessary is a thread rule which catches all cases as the default, as shown here. 

default: ( .

( (   =  Tab )

If the group contains folders, then subdirectories corresponding to the folder names will be created under the base directory. The individual files will be placed into these folders.

· If we expand on the above idea a little, we can envision a similar situation, except that "Doc" files should be put in a subdirectory called "notes". 

Filetype:









case Doc: ( notes

default: ( .

· It is also possible to use the settings of ONE_OF_MANY attributes as variables that are expanded when the script is generated. If we wanted to implement a directory structure where source code was scattered across one of several possible subdirectories, then we may choose to have configured the group to have a ONE_OF_MANY attribute called "Subdir". We could then use rules such as the following... 

       Filetype:










      case Header: ( #Subdir#







      case C:    ( #Subdir#








      case Doc:    ( notes








default:     ( .

NOTE: The Thread_rules file applies to both the Generate Script and Extract Thread buttons on the Utility menu. 

Changing how files are extracted

When new groups are created, a file called Thread_script_template.sh is placed in the Tables directory for the related thread. This template contains the method for file extraction. When a thread script is generated, this file is copied to the destination script name, and the actual commands to get the read-only copies of the files are appended to the file. 

The lines that are added to the script are of the form shown below: 

get_file <filename> <version> <destination> <is_binary> <new_name>

...where <filename> is the file that is being extracted, <version> is the extracted version of that file, and <destination> is the location to put the extracted file. The parameter <is_binary>, can have a value of either "0" or "1", with "1" meaning the file being extracted is a binary file ("0" means it's a text file).

Lastly, the parameter, <new_name>, will only be used if the thread needs to extract a file that had been removed from the database since this version ofthe thread was created; the archived filename will have to be renamed to the original name. 

The actual definition of the get_file command is what is provided by the template. By changing the template file, you can in effect change the natural behavior of what the generated script will do. 

For example, using the default template, as the script runs it will overwrite any existing file that happens to already be in the destination. You may opt to rewrite the script such that the get_file command will overwrite the existing file only if it passes some tests (which are up to your discretion). 

Before changing the template, it is suggested that you first study and understand the one provided. It is well commented, and should serve as a good example. 

In addition to the general template provided (above), a second script is placed into the Tables directory at the time the group is created. Thread_script_after_template.sh. The contents of this file are appended onto the end of the final script being generated. 

The sample automatically provided does nothing more than `exit 0'. You are free to change the contents to be whatever you wish. A common example is to have the script kick off a compilation or massive print job after all of the files have been properly retrieved. 

Comparing threads
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It is often important and useful to be able to see what differentiates one thread from another. Fortunately, there is a simple means of doing just that. By selecting the Compare option from the main display's Utilities menu, the following panel will appear. Fig 6.3

Fig 6.3

Using the mouse, the user identifies which thread/version is to be on the left, and which is to be on the right. Selecting the Compare button at the bottom of the panel runs the analysis. The output lists all files currently in the group along with each file version. The last column identifies the type of change as "No change," "Included," or "Excluded." If desired, the results can also be saved to a file with the Save button. 


Projects: Thread of threads

In many cases, a development effort is the result of bringing together several threads from several different groups. Since the co-ordination and management of these threads can itself become complicated, Razor allows you to generate a special thread of threads, called a project. These are defined and stored under the special group named -PROJECT-, which appears as the last option under the Groups pull down menu. 

The project editor
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To create a new project, you must first select -PROJECT- from the groups menu, and then choose the New Project option from the File menu. To edit an existing project, simply double click the mouse over one of the existing project names listed on the main display. In either case, the Project Edit panel will appear, as shown below. Fig 6.4

Fig 6.4

There are three columns to the rows on the list. They indicate the thread name, which version of that thread is part of the project definition, and which Razor group that thread relates to. (Note that you can control whether the list is sorted by the names of the threads or the groups they refer to with options on the View menu). 

Defining the collection of threads

Modifications are made to the project definition through the options on the Edit menu, as shown below. Fig 6.5











Fig 6.5
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There are three elements which combine to form entries in a project definition. The first is the Razor group the thread relates to, and is selected from the Groups menu. Secondly, for the selected group, the upper left corner of the panel shows all of the known threads. Third, for whichever thread is selected, the scrolling list in the upper right shows all of the possible versions of the thread. As selections are made in the two lists, the Title and Description fields are updated to show what commentary was entered at the time of creation. 

If the panel is up in "add" mode, then selecting the Apply button will allow more and more items to be added to the list. If the panel is up in "edit" mode,  then apply only changes the definition of the particular thread of interest. 

Controlling your view

Razor provides you with a variety of options for controlling and organizing what is presented to you. 

Date information

As shown earlier, the main display contains a scrolling list of the names of all the existing threads for the defined group. It is occasionally useful to also show information relative to when the thread was last modified. 

By enabling the Days since last mod(^l) option from the View menu, the display will widen and add a note of the number of days since the thread was last modified. Similarly, you can choose the Modification date (^m) option from the View menu and the main display will now include the exact date of the last modification. A sample threads display with both Modification date and Days since last modification would be shown as  Fig 6.6
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Fig 6.6

As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year of the modification. Dates less than 6 months ago will display the date and time of day that the edit occurred. 

Filtering the display

The threads program allows you to have a large number of threads within a single Razor group. This in turn can yield a particularly long and unfocused list being presented on the display. 
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It's possible to reduce and restrict the list to only those threads which meet certain selection criteria. Selecting the Display Filter option from the View menu (or using the ^F hot key) will bring up the following control panel. Fig 6.7

                                                                                      Fig 6.7

Perhaps the best way of becoming familiar with the concepts of filtering the display list is to simply experiment with the above panel. Nonetheless, the following notes should help you understand some of the basic themes. 

By entering text in the Name pattern field, you can restrict the list to only those threads that follow a particular naming convention. For example,  entering the string "Test*" will prune the list to include only those threads beginning with "Test". The Options menu allows you to toggle between using normal UNIX style wildcarding or regular expressions for matching. 

As restrictions are entered on the panel, the left footer will show a count of how many files within the group match your interests. Selecting the Apply button will cause the matched files to be displayed on the main list. It's possible to have the count updated either on a keystroke by keystroke basis, or only after typing a tab or carriage return. This personal preference is set from the Match while typing option of the Options menu item. 

Issues 

The issues program is the problem tracking part of the Razor trilogy. 

Although its most frequent implementation is as a problem tracking system, it can actually be configured to satisfy all sorts of needs, for example, change requests. 

The main display

The main display of the issues program consists of a window header/footer, a menu bar, a tool bar, a large scrolling list as shown below.
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You choose commands from either a menu, tool bar button, or shortcut keys (shown with menu items). The tool bar buttons provide convenient access to the more frequently used functions. 

Header/footer

The window header will contain the program name. It may also contain the issues group name. The left footer of the display gives some simple metrics about how many issues are known to the system, and how many of those are actually represented in the scrolling list. The right footer will normally display the version number of the release of Razor you are using (not as shown above). 

Menu bar

The menu bar contains the menus File, View, Reports, Commands, Database, and Groups. 

· File contains the file-related commands New Issue and Exit. 

· View contains a collection of view manipulation and selection commands, such as selecting/deselecting all items in the list, showing/hiding the tool bar, and various filtering/sorting options. 

· Reports contains a menu of site-specific, customizable reports scripts that operate items selected in the issues list. 

· Commands contains site-specific commands. 

· Database contains site-specific databases. 

· Groups contains a list of issues groups available for this database. Selecting from the Group list will access that group and update the title bar. 

Tool bar

In order to simplify access to some of the more useful functions, the issues program shows a small toolbar on the main display. The buttons provide quick access to themes discussed later in this chapter, but a quick overview here may eliminate confusion later.
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As you move the cursor over each of the above buttons, the right footer will provide a reminder of the function of each button. 

If you are also using the Razor program for version control, you may also have a `Drag and Drop' icon on the far right of the toolbar (At least one issue must be selected to enable drag-and-drop. See "The drag-and-drop method”).

Main list

By default, the scrolling list displays each issue contained within the indicated group. Each line on the scrolling list represents a separate issue in the database, and consists of three sections; a collection of glyphs offering information about the settings on the issue form, the issue number itself, and a one line text summary of what that issue is about. 

The sections of an issue form

All issue forms consist of the following... 

· A fixed collection of attributes, presented as on-screen entry fields, selection boxes, toggle switches, etc. (collectively known as widgets). 

· Two text panes, free format text area, typically used to contain the initial definition of the issue to be resolved and the resolution. 

The attributes, as well as the initial text which may appear in either of the two text panes are controlled by the Razor administrator. 

An example of an issue form is shown below.
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The attribute section

The list of attributes is presented below:

· Title: It is a text field for the entry of a single line to be used as problem description in the main display.

· Priority: It is the problem priority. It may take one of the following values: non-critical, serious or critical.

· Impact: It is the problem impact. It may take one of the following values: low, medium or high.

· Scope: It is the problem scope. It may take one of the following values: support, duplicate, software-bug, documentation or change-request.

· Originator: It is a text field for the entry of a single line to specify the full name of the person who creates the problem.

· Originator Email: It is a text field for the entry of a single line to specify the e-mail address of the person who creates the problem.

· Problem Category: This field is a menu that shows a list of categories. This list depends on the database and group you are using because every group has its own categories. Categories are used to distribute the problems of a group to the appropriate people.

· New Responsible: This field is a menu that shows a list of people, being possible to select one of them to assign a developer to solve the problem. This list depends on the database and group you are using because every group has its own developers.

· Problem Start Date and Time: This is a date/time field to specify when the problem is submitted. The format is: Mar/11/1999 09:29:45. Although you are allowed to type directly into the field, is more useful to select the button to the left of the field  and a panel similar to the one below will appear, offering a more controlled means of entering the data.
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· Problem End Date and Time: This is the date/time field to specify when the problem is closed.

· Description of Environment: It is a text field for the entry of a single line to specify the environment where the problem happened. 

· State: It shows the current state of the problem. It may take one of the following values: Submitted, Accepted, Rejected, Assigned, Feedback, Suspended or Closed. 

Text panes

There are two text panes:

· Description, How to reproduce the Problem and Recommended Solution: This text usually is introduced by the problem originator for describing it.

· Actions Taken: This text usually is introduced by the developer who solves the problem to describe all the actions taken for it. The person who assign a responsible to solve a problem may also use this text pane to introduce all the pertinent information, for example, actions to be taken, estimated start date and end date.

Working with text panes

Unlike the single line text fields which may be in the top of an issue form, these text sections are effectively of infinite length. You are free to expand on them and fill them out as you see fit. The normal paradigms of using the mouse to select the insertion point, etc. are honored. 

Including files into the text panes

New issue forms will appear with some collection of initial text. You are free to edit and add to whatever is already in those fields.

Occasionally you may wish to include the contents of another file directly into one of the text panes. It may contain source code, an error log, or some other information you find useful. To facilitate this, a special extension to the text fields has been provided. By holding down the right button on the mouse, a menu will appear allowing you to bring up the panel shown below.
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After you've maneuvered to find the text file you want included, select either Ok or Apply at the bottom of the form. The contents of the selected file will be inserted directly into the text pane where you had last left the insertion point.

Lifecycle of an Issue

An issue may take one of the following states:

· Submitted: The issue has been created. Later, every time an issue is modified the state attribute may take one of the following values.

· Rejected: The issue (in this case the issue would be a change request) has been rejected.

· Accepted: The issue (in this case the issue would be a change request) has been accepted.

· Assigned: A developer has been assigned to solve the issue.

· Suspended: The issue is suspended for a time by the developer.

· Feedback: The developer has taken some actions to solve the issue and he/she is waiting for the feedback of the problem originator.

· Closed: The issue is successfully solved and is finished.
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The possible transitions between states (lifecycle) are shown below:

This is the best moment to introduce a new concept: Category Team. Every category of a group has a people team associated who is the responsible for solving all the issues in that category. This team must be composed for unless one person (First Responsible), and it may be composed for as many people as you want. To add o remove a person in a category, please, contact the Razor Administrator.

E-mail notifications on state changes

How does a Category Team know that an issue has been created? How do the interested people know about the current state of the problem? How does the assigned developer to solve the problem know that he/she has to solve the issue?

To carry out all these notifications, the chosen method is to send e-mail on state changes to the pertinent people. More in detail, the e-mail notifications are the showed below:

· When the issue reaches the Submitted state:

Mail to: First Responsible in Category Team.

Cc: Others in Category Team + Originator.

· When the issue reaches the Rejected state:

Mail to: Originator.

Cc: Everybody in Category team.

· When the issue reaches the Assigned state or the assigned person to solve the problem is changed (This is possible if the current state of an issue is Assigned and somebody modifies the Assigned Person of the issue without changing the state).

Mail to: Assigned person (developer).

Cc: First Responsible in Category Team.

· When the issue reaches the Closed state:

Mail to: Originator.

Cc: Everybody in Category team.

Permissions to modify an issue
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A new issue may be created by anyone, but once it is created only the allowed people may to modify it. The allowed people to modify an issue depend on the current state of the issue. The permissions are showed below.

The letters on an arrow means the permissions for state changes and inside an state means the permissions for modifying an issue in that state without changing the state. The meaning of the letters is:

(E): Everybody in Category Team.

(A): Assigned person.

Creating new issues

To create a new issue through the GUI, you can either

· select the New Issue option from the File menu, or...

· type ^N, the related hot key, or...

· select the new issue button on the tool bar. 

After selecting New issue, a new issue form will be displayed for modification. Complete the form with the appropriate information. The table showed below indicates what fields are possible to modify and what are obligatory.

Field
Modifiable
Obligatory

Title
Yes
Yes

Priority
Yes
No

Impact
Yes
No

Scope
Yes
No

Originator
Yes
Yes

Orig. Email
Yes
Yes

Problem Category
Yes
No

New Responsible
No
No

Problem Start Date and Time
Yes
No

Problem End Date and Time
Yes, not recommended
No

Description of Environment
Yes
No

State
No
No

Description, How to Reproduce the Problem and Recommended Solution
Yes
No

Actions Taken
Yes, not recommended
No

Once the form is filled out to your satisfaction, you can select the Ok or Apply buttons at the bottom of the display. Choosing Ok will accept all the entries and remove the form from the display, while Apply will keep the form up for view. The Cancel button will remove the form from the display and result in no new entry to the database. The Reset button will clear any modifications you may have made to the form and start you over with initial settings for each of the input areas.

Viewing/modifying existing issues

There are two main mechanisms for bringing up an existing issue for review through the GUI. The first, and perhaps the most intuitive, is to scroll through the main list until you see the one you are interested in, then double-click the mouse over that line. 
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A second method is to call it up directly by its issue number. To do this, use the Issue number option from the View menu, press ^I, or use the related button on the toolbar. However you do it, the popup shown below will appear. 

The issue form will initially come up in Review mode. In order to make edits to the form, you must first change the state of the toggle in the upper left corner of the form to Modify. By doing so, you are preventing anyone else on the system from simultaneously making edits to the same issue. An example of the issue form is shown below.
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There are a few restrictions for modifying an issue:

· The New Responsible attribute is modifiable only when the current state of the issue is Assigned.

· When the state of the issue is Assigned then to fill in the New Responsible attribute is obligatory.

· Not all the state transitions are allowed, just what are explained in the lifecycle of an issue.

Remember that not everybody is allowed to modify an issue, see Permissions to modify an issue.

Checking on related file activity

If an issue has been related to an activity in either the file version control or release management aspect of Razor (the versions or threads programs), then a button labeled Activity will be available in the top right corner of the issue form (refer back to the issue form shown). Selecting this button will result in a new popup being displayed (like the one below), displaying a synopsis of all the related file, thread and project operations.
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For information on how issues can be associated with file activity in the versions program, see "Associating issues to editing activity", or with the creation/update of threads, see "Defining threads by related issues". 

          Recording your modifications

After you have modified the information on the issue form, select either Ok or Apply at the bottom of the form to record your edits with the database. Selecting Reset will undo all of your edits since you took the issue into Modify mode. The Cancel button will pop up a dialog similar to the one below.
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Selecting "Yes, dismiss the form" dismisses the form and no changes will be applied to the database. "No, don't dismiss the form" will return control back to the issue form. 

It is possible that someone else may have modified an issue while you were viewing it. If so, you will see this at the top of the issue form.
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You will not be able to modify this issue. Your only choice is to select Cancel and reselect the issue.

Controlling your view

As its initial default, the issues program will display all entries known to the system in numerical order. Over time, this can grow to be a very large and unwieldy collection. Razor provides you with a variety of options for controlling and organizing what is presented to you. 

Additional information on the main display

Glyphs...

There are glyphs (pictures) associated with two attributes on the issue form.
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Glyphs for the State attribute: 


Glyphs for the Priority attribute:
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Date information...

As shown earlier, the main display of issues normally contains lines showing only the issue number, a line of descriptive text, and possibly some glyphs. It is occasionally useful to also show information relative to when the issue was last modified. 

By enabling the Days since Last mod option (^l) from the View menu, the display will widen and add a note of the number of days since the issue was last modified. Similarly, you can choose the Modification date (^m) option from the View menu and the main display will now include the exact date of the last modification of the issues. 

Both of the above toggles can also be accessed from toolbar buttons.  

As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year of the modification. Dates less than 6 months ago will display the date and time of day that the edit occurred.

Filtering the collection

As the list of issues grows, it may be necessary to limit it to just those that are of particular interest or have something in common. Filtering the issues list provides a finer level of control of the issues display. 

By choosing Filter & Sort from the View menu (or using the filter and sort toolbar option), a popup similar to the one shown below will appear. You are free to move and resize it as necessary on your display.
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Three menus provide control over various aspects of the filter operation. 

· File contains a number of filter file operations including resetting the filter form, saving the current filter, saving the current filter as another name, and modifying/deleting filter files. 

· Options contains filter/sort controls such as invert sort order, sort by modification date, case-insensitive sorting, and match while typing. Match while typing will continually display the number of matching issues as the filter form is updated. 

· Filter contains the list of saved filters. Selecting a saved filter recalls it and displays the filter/sort options. 

You'll note that the widgets on the Filter & Sort display are closely mapped to the widgets that appear on the top of an issue form. These are used to define which issues on the main collection are of interest to you. 

Filtering by matched settings...

All of the attributes on the issue form which provide a choice of options are presented on the Filter & Sort panel as an X_OF_MANY selector (you can select several values for an attribute). As you toggle the options on the Filter panel, you are indicating your interest or disinterest in issues which match your selections. 

For example, if you were interested only in issues that were assigned a critical priority, you would select only the critical option on the Filter panel. 

If you wanted to see every issue except the critical priority ones, you would select the non-critical and medium boxes, but not the critical.

Within a particular filter widget, an issue is considered a match if any of the selections hold true. 

Filtering by matching text strings...

It is possible to filter the issue collection by matching particular text strings. Character sequences entered into one of the text widgets on the Filter Panel form UNIX regular expressions which are compared against each issue in the system. In their simplest forms, a regular expression just searches for a string which contains what you have entered, and this is often sufficient. 

As a convenience, the Options menu contains a checkbox which indicates whether or not you want the text searches to be case sensitive. If it is not selected, then case is considered. If it is selected, then the case is ignored. 

As you enter the search string into the text field of the filter panel, the issues program does a pass through the database for each character as you type. The left footer of the filter panel displays a count of how many matching entries are found. If you prefer to not incur the slight performance hit this approach presents, then you can turn off the match while typing feature from the Options menu. When disabled, the footer display is only updated when the keyboard focus moves someplace else. 

Filtering by time...
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A powerful mechanism for filtering what is to be shown on the primary display is by time stamp. The issue form presents time stamps as a text field with a button beside it         instead of a label.

The text field itself is not directly editable. By selecting the related button however, a new popup will appear which provides a more programmatic and controlled mechanism for entering the desired date range.

As with entering timestamp information on the form itself, you use the pull down selectors to enter the desired month and day, and type in the year. To make entry of certain fields easier, you can also take advantage of the From and To menu entries which allow the setting of either field to specific relative dates (yesterday, a week from now, etc.). Please note that the top field represents the beginning of the desired date range and the lower field represents the ending of the date range. 

Combination filters...

When you have made settings in more than one of the widgets on the Filter panel, you are creating a more sophisticated match criteria. The effect is that a particular issue will end up on the main list only when it matches each of the tests you have set up. 

Sorting the collection

If no sort specifications are indicated, then all of the issues which pass the filter criteria will be arranged purely by the issue number (which is also indicative of the order in which they were entered into the system). By setting the sort criteria however, you can adjust the natural presentation order more to your liking. 

Sorting by attribute setting...

On the filter panel, to the left of widgets that can be sorted, is a menu button, as shown below. 

By identifying an attribute as "1st", that will be the primary key used for ordering the issues on the main display. In the case of tied values, the sort criteria resorts to the 2nd, and then the 3rd and 4th in order (if defined). 
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Using this capability, you could arrange to have your main display ordered first by Priority, and secondly by Category (or the inverse). This, in combination with effective filtering, provides for quick and powerful insight into the collection of issues. 

Sorting by modification dates...

In the case of tied sorts (as defined above), the main display will naturally resort to ordering the issues by the issue number, which is indicative of the order in which they were introduced to the database. Occasionally, it is useful to have the issues sorted by the last time modified. This gives insight as to where the most recent or most distant activity has occurred. 

To activate sorting by modification date, select the Sort by modification date option from the Options menu of the filter panel. This setting will also be noted in the footer of the filter panel itself as a reminder. Note that the setting of this toggle will not take effect until the user next selects the Apply button on the filter panel. 

Changing the sort order...

Finally, the issues program naturally sorts the entries from lowest to highest value. You can invert this tendency by choosing Invert sort order option from the Options menu. This setting is also noted in the right footer of the filter panel as a reminder. 

Note that the setting of this toggle will not take effect until the user next selects the Apply button on the filter panel. 

Saving and recalling sort/filter combinations

Since the issues program allows you so much flexibility and control over the filtering and sorting of the main list, it also makes sense that users should be able to save their favorite settings.

To facilitate this, there are a collection of options under the File menu of the filter panel. Most of these are self-explanatory, and do not warrant a detailed description. The key point is that you can create/modify/save/delete filters and associate names to them. To designate one as the default filter applied when issues is started, use the Modify/Delete Filters option, select the desired startup filter and select the Use as startup default option.

Searching for matching text strings

The power to filter and sort the list of issues as described above is restricted to utilize only the information contained in the collection of attributes at the top of the issues form. As such, they are very fast and efficient. Occasionally however, you may want to search for text strings within the body of either of the two free format text sections. 
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Selecting Text Match from either the View menu or from the toolbar, will bring up the Text Match popup. 

The Text Match popup has File, Match, and Reports menus. 

· File contains the Exit window entry. 

· Match permits matching using both or either of the two text areas. 

· Reports contains the full list of reports that can be applied against the issues that match the text search. 

To perform a search for matching text strings, you would enter UNIX style regular expressions into either or both of the text lines at the top of the form. Selecting the Apply button will cause the issues program to begin a scan through the pre-filtered collection of issues. 

The first key is compared in the first of the two text fields on an issue form; the second key is compared in the second text field. Either of these may be left blank by the user. Whether or not a `hit' in both or either of the text fields is required is controllable by the user through the Match menu at the top of the panel. The right footer of the display shows a reminder as to what the prevailing logic is. 

Since entering a case insensitive regular expression is often tedious, you can have the issues program do it for you by toggling the state of the checkbox just below where the keys are entered. 

Doing a text match search for issues is not as efficient as normal filter and sort operations of the attributes. Since these searches are performed against only those issues on the main display of the program, you can improve performance significantly by first filtering the list to those of interest. 

Once a search has completed, the scrolling list on this panel will contain a static subset of the issues on the main display. You may double click on lines in this subset to bring up a copy of the issue, just as you would off the main display. 

Please note that this subset list shows the results of a single pass through the issue collection. Whereas the main issues scrolling list is dynamically updated to reflect changes that other users may be making in the database, this subset list is not. 

Getting more insight and output

Printing issues

In the upper right corner of each issue form is a Print button. Selecting that button will cause a copy of the issue to be printed. 

Running reports

The Reports menu bar option on the main display pulls down to a collection of locally defined shell scripts which can be run against the items selected on the main list. To add your particular scripts for generating reports contact to the Razor Administrator.

When activated off the menu bar, the selected report will only be generated for the issues you have selected from the main display list, and it will be run against the issues in the order they appear. Through combinations of filtering and sorting the collection (discussed previously) you have great control over the scope of the report. 

Depending on how the report script has been attached for use, you may see a small popup which gives an indication of which issue is being worked on. Once completed, a window will appear, containing the output of the report.

If you wish, you can use the Save button on the bottom of the report window. It allows you to identify the name and location of a file where the results of the report can be saved, perhaps for future printing or e-mailing to other team members.

NOTE: Since the reports are generated by shell scripts, it's possible that some of the options on the menu may send their output directly to a printer for you. In fact, they can be configured to do a great deal more than simply produce textual output. It is up to you determine what you want a "report" to actually do. 

Running commands

Selecting from the Commands pull-down on the main display menu will simply invoke the command for all the selected issues. The result is presented to the user in an output window. For example, there is a command for deleting issues.

Switching between databases & issues groups

Database selection list will be available on the menu bar. When a different database is selected, the current issues database will be exited and the new one will be accessed. The database server must be running to access its issues. Now the Database menu item on the main issues screen will be enabled; selecting that menu will display all possible database choices. 

The Groups menu appear on the menu bar of the issues tool, and selecting a group other than the default will switch to that group's issues and the name of this newly selected group will appear in the title bar. Just select and go. 

Glossary

ASCII 

An acronym standing for some arcane phrase. Basically, it means simple text, nothing more. 

attributes

Characteristics of an object. For Razor, these characteristics define how an object is presented on the display and how it is stored in the database. Examples of attributes types are ONE_OF_MANY, X_OF_MANY, TEXT_FIELD, STATE, CHECK_BOX TIME_STAMP and LABEL.

binary file

A "binary" file is typically considered to be one which contains something other than simple ASCII text. In the context of Razor, a binary file is treated specially, in that the versions program will use its own archival scheme instead of SCCS/RCS. 

bitmap

The bitmap program is supplied with most X installations, and is a perfectly fine package for generating the simple bitmap files which can beattached as glyphs to the issues, versions, and threads main displays. 

blessing

Level of promotion. 

branching

To create a separate, uniquely tracked version of a file already under control. A branch is often created to make parallel changes to a file. These changes are later merged into the main line and the branch is terminated. 

CHECK_BOX

A widget which can have a value of set (1) or not set (0). 

check-in

Return a file to the archive and remove the lock placed on it during a check-out operation. 

check-out

The operation of obtaining an editable copy of a file and locking it so that others may not edit the same version at the same time. 

check-out readonly

Obtain a readonly copy of a file and not reserve it for edit. 

CM

Configuration Management. 

drag and drop

This is a common parlor trick employed by some GUI's. It allows you to physically drag icons across the screen from one place to another instead of typing in commands to make associations or rearrange file structures. For example, the Razor program allows you to use this technique to associate issues to editing activity. 

environment variable

This is a variable defined within a shell which may be used by various programs to control or alter their behaviour. 

filename expansion

A set of meta-characters may be used to define the expansion of filenames. Simple examples such as `*' matching all characters and `?' matching any single character are commonly used. See UNIX in a Nutshell from O'Reilly for a full discussion of filename meta-characters. 

glyph

A small graphical image, used in the Razor programs to provide insight to the various files and issues under control. See bitmap. 

group (UNIX)

All users on a UNIX operating system belong to at least one group, sometimes many. A UNIX group provides the ability to grant/limit access to files based on membership. 

group (Razor)

A collection of related files, all containing unique names. Sometimes viewed as being similar to a directory. 

GUI

An acronym for "Graphical User Interface." Pronounced so as to rhyme with Huey, Louie, and Dewey. 

hard rule

A `hard rule' is a local convention that is being enforced by the Razor tool set, typically as the result of the judicious attachment of shell scripts to the various Razor activities. This differs from a `soft rule', which is a convention agreed upon by the members of a team, but which has no programmatic enforcement. 

History file

The place in the Razor database where historical information regarding all operations on an object have occurred. This file can be found in the History directory for the appropriate Razor group. 

HTML

Hypertext Markup Language. 

icons

Graphical representations on the desktop. 

iconic

When a window is minimized to a small picture (icon) on the desktop. 

Info file

The place in the Razor database where current status of an object is maintained. This file can be found in the Info directory for the appropriate Razor group. 

Internet

If you need to be looking this up in a glossary, you've been on mental vacation a bit too long. Did you have a nice time though? How was the weather? 

Issue form

The object which represents an issue. 

issues

A first rate program which may be used for problem reporting, bug tracking, issue definition, job jar, help desk, customer calls, etc. 

LABEL

An attribute type used in issues to represent a text only field. This attribute is often used to provide commentary or act as a visual delimiter on an issue form. 

locking a file

 (see check-out) 

major version number

See `version number' 

minor version number

See `version number' 

Motif

A widget set put together by a consortium of contributors to provide a consistent interface in the X-windowing environment. 

ONE_OF_MANY

ONE_OF_MANY_LIST

ONE_OF_MANY_STACK

An attribute type which defines a list of items to which exactly one must be selected. The ONE_OF_MANY object is displayed as a group of toggle buttons while the ONE_OF_MANY_STACK are represented as a pull-down menu. 

OpenLook

Sun Microsystems' attempt at a standard widget set for the X-windows environment. They ended up abandoning it. 

OS

An abbreviation for Operating System. 

owner of the database

The user who owns the RAZOR_UNIVERSE directory in a Razor database. This user will also own all subdirectories under RAZOR_UNIVERSE when a new database is created. Care must be taken to insure that modifications made to the configuration of the database be performed by this user. 

pattern matching

 (see regular expressions) 

problem report

Although everyone has their own ideas on this one, we choose to be generic and refer to them as issues. What makes the most sense to you will stand as your definition. 

Promote/Promotion

The ability to indicate that a file or issue has attained some level of maturity or importance. 

project

A collection of threads. Sometimes referred to as a thread of threads. 

QA

Quality Assurance. QA people are charged with the reponsibility of ensuring a product is stable and meets customer requirements. 

razor

A collection of command line interfaces which allows users access to Razor system commands and also allows them to extend some of the GUI functionality to a command line task. 

RCS

"Revision Control System" -a freely distributable revision control tool; functionally and conceptually similar to SCCS. 

regular expressions

A means of defining simple or complex text patterns using standard characters and special characters. 

revert

To make an older version of a file the latest version. Versions are not lost during this operation, rather a new instance of the reverted version is created as the latest file version. 

revision

A modification, an update. 

SCCS

"Source Code Control System" - a revision control tool. 

soft rule

A `soft rule', is a convention agreed upon by the members of a team, but which has no programmatic enforcement. This differs from a `hard rule' which is being enforced by the Razor tool set, typically as the result of the judicious attachment of shell scripts to the various Razor activities. 

state

A level of promotion that an issue, file, thread or project has attained. 

TEXT_FIELD

An attribute type which presents itself as a widget in which textual information may be entered. 

TEXT_PANE

An attribute type which presents itself as a pane in which textual information may be entered. 

threads

A tool in the Razor suite which allows users to define collections of files by name and version. 

thread

A single collection of files defined by name and version. 

TIME_STAMP

An attribute type used in issues to allow for the input of time based information. The format of the input is configurable. 

version number

A version number is broken up into a number of parts (up to 4) as follows:

release.level[.branch.sequence]

The release number (sometimes referred to as major number) and level (sometimes referred to as minor number) will always appear. Each time an object is modified, the level will change automatically. The release number can also changed if the user chooses to have it changed. The branch and sequence numbers are used only for branch files. The branch number will indicate which in the sequence of branches from the release it occurred. The sequence number behaves in a similar fashion to the level number. 

versions

A tool in the Razor suite which provides for file version control operations. 

Wdefaults

 (see Xdefaults) Emulates X resource settings on PCs. 

wildcards

 (see filename expansion) 

X_OF_MANY

X_OF_MANY_LIST

An attribute type which defines a list of items to which any combination of items may be selected. 

Xdefaults

X Resources

Default definitions for widgets and other X based application resources. These definitions can control such things as font, color, height, width, etc. 
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Type in the name of the folder


you wish to have created and


select the OK button
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File Version





Glyph showing


File type
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Text pane 1





Text pane 2





You can either type in the name of the directory you wish, or use the mouse and double-click on entries to ‘walk’ your way there.





Select the file you wish to have included into the text field on the issues form.





Entries here help filter the scrolling list above by either normal UNIX wild carding or by regular.
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You can enter the issue number as either its fully annotated form (I..1-234) or simply as an integer. Entering a carriage return is the same as selecting the Apply button.





Changes are permitted only if in Modify mode





Print issue





Related file activity





Submitted


Accepted


Rejected


Assigned


Suspended


Feedback


Closed
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non-critical


serious


critical
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Issues which match the searches above will be listed here.
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